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About Radioddity 

‘You, our friend and customer, are our focus” 

At Radioddity, our customers are important to us. As a customer, your time and 

money are important to you. When you buy radios online, you face a dilemma: 

buy from a reputable website at a high price, or try to save money by choosing a 

retailer that may not offer quality goods, service or advice. At Radioddity.com, you 

don't have to choose between low prices and a safe shopping experience. 

Whether you are a first-time shopper or an experienced radio amateur, we always 

do our utmost to ensure that you get the best possible value for money. Over the 

past few years, Radioddity has continuously strived to better meet the needs of 

wireless equipment buyers and has become a reliable partner. We do this by 

offering the highest quality products at an affordable price and by providing you 

with first-class support after purchase as well as out of warranty. Because as our 

customer, you deserve nothing less. 

 

Our promise: To offer you the best shopping experience 

Strong partnerships enable us to offer you the latest technologies with an 

excellent price/performance ratio under the Radioddity brand name. Our 

experienced and responsive customer service team helps us to deliver on our 

promise to you and better meet your everyday needs. Whether it's offering you 

the latest and greatest DMR, HF and analog radios, accessories and related 

products, providing outstanding technical support or working with amateur radio 

industry leaders to develop helpful content to assist you with your purchase: Your 

concern is our concern. We want to provide you with quality radios at great prices. 

If you feel we are not delivering on this promise in any way, please let us know by 

e-mail:  

support@radioddity.com 

Copyright© 2025 by Radioddity 

All rights reserved. This manual or any part of it may not be reproduced or used 

in any way without written permission from the publisher, except for brief 

quotations in critical reviews and for certain other non-commercial uses 

permitted by copyright law. For permission requests, please contact the 

publisher. 

Windows™, Linux™ and OS X™ are trademarks of their respective owners. If a 

trademark assignment is missing, incorrect or erroneous, please contact us as 

soon as possible so that we can correct this immediately. 

 

mailto:support@radioddity.com
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1 Firmware release notes 

The following table lists the details that have been changed with new versions of 

the Radioddity GD-168 firmware and CPS. Generally previous updates are 

included in the latest version. Normally only the main firmware of the radio needs 

to be updated. Currently the icons and the base band 3288 firmware are still 

unchanged since its initial sales. However, we have included the corresponding 

files and utility program within the update archive as well. 

Note: Never update your radio if it is not really necessary, or in other words: 

'Don't fix it if it's not broken'! This cannot be emphasized often enough. 

To update the Radioddity GD-168, only use the firmware that you can find 

on our support pages. Using other firmware will void your warranty. Before 

carrying out an update, make sure that the firmware is still available for 

download on our support page. All firmware updates for the Radioddity 

GD-168 are supplied with 'Release Notes'. 

 Please carefully read the 'Release Notes' and 

 all documents contained in the firmware archives! 

1.1 CPS: V1.07, Icon: V1.34, SCT 3288: V3_01_01A5 

revision Changes released 

V1.07 

• Resolve the issue that Satellite TX frequency is 

incorrect. 

• Resolve the issue that Satellite passes are 

inaccurate. 

2025-06-14 

1.2 CPS: V1.06, Icon: V1.34, SCT 3288: V3_01_01A5 

revision Changes released 

V1.06 

• Resolve the issue that APRS doesn’t work. 

• Resolve the issue that GPS info menu was missing 

the Edit button. 

• Resolve the issue that Satellite AoS (Acquisition of 

Signal) limit doesn’t work. 

• Resolve the issue that TOT Predict does not work. 

• Resolve the issue that when listen to a Satellite, the 

radio doesn’t have a sound when SQ set 0. 

• Improve the scan speed. 

• Resolve the issue that other radios AES 256/ARC4 

encrypted communication is not properly received 

• Resolve the issue that receiving a digital repeater 

signal in mixed-mode is not working as expected. 

• Resolve the issue that the radio doesn’t display the 

satellite name after the satellite information has 

been loaded. 

2025-04-29 
Not officially 

released 
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1.3 CPS: V1.05, Icon: V1.34, SCT 3288: V3_01_01A5 

revision Changes released 

V1.05 

• Improve the scan speed. 

• Allows APRS Transmit under Satellite menu, press 

PTT+PF2 button to transmit the APRS. The APRS 

shall be set up in CPS → Tool → GPS Satellite Data 

Update → AprsTxFreq(Hz). 

• Allows Arm CTCSS transmit under Satellite menu, 

press PTT+PF1 button to transmit the ArmCTC or 

DCS. The Arm CTC or Arm DCS shall be set up in 

CPS →Tool →GPS Satellite Data Update → Arm CTC 

or Arm DCS first. 

• Separate the color code for TX and RX in channel 

setting. When you load the old. rdt file to the CPS, 

the CPS will come up with a screen that asks 

whether you want to let the TX CC be the same as 

RX CC, click on Yes will make the TX CC= RX CC 

• Move CRC ignore into each channel setting instead 

of a global setting that would apply to all channels. 

• CPS → Optional Setting → Satellite → SAT Aos limit, 

allows to set up the Elevation/Degrees for the 

satellite. 

• CPS → Optional Setting → Satellite → SAT Fix 

PointName 1-8, allows to set the name for Fixed 

location 1-8. 

• CPS → Optional Setting → Display → Night Start 

hour, Night Start Min, Night end hour and Night 

end Min, it allows to set up the Night time, the 

radio will switch to night mode automatically in the 

night time period. 

• CPS → Tool → GPS Satellite Data Update, allows to 

import and export the satellite data in .CSV file 

format. 

2025-01-23 
Not officially 

released 

1.4 CPS: V1.04, Icon: V1.34, SCT 3288: V3_01_01A5 

revision Changes released 

V1.04 

• AES256 function – Improve the issue that the radio 

operates incorrectly if using  AES256 encryption. 

• Mic function – Improve the issue that some radios 

have low transmit audio. 

• Ext speaker microphone – Improve the issue that 

using FW V1.03 with external mic speaker on a 

DMR repeater channel, if the repeater doesn't 

reply when PTT is pressed, no tone is played. 

2024-12-3 
Not officially 

released 
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1.5 CPS: V1.03, Icon: V1.34, SCT 3288: V3_01_01A5 

revision Changes released 

 

 V1.03 

• Satellite function (only available if a fixed GPS 

location has been defined with the CPS) 

- Allows set up power for Satellite separately from 

channel power. Press * key to switch the power 

level when the radio is in Satellite mode. 

- Improve the issue that radio stuck during 

predicting. 

- Allow the radio stay at the satellite menu, ignore 

the menu exit time setting. The radio will exit 

Satellite menu by pressing the return key only. 

- The CPS → tool → Satellite Data Updating, this 

page is updated to allow input different 

download link for satellite information update 

use. 

• In CPS → Digital → Master ID, allows set up a 

Master ID for the radio. In radio menu → Setting → 

Channel Set → Radio ID, if you select the master ID 

in a channel, all the channels will switch to use 

master ID, it is a public setting for all channels. It is 

helpful when you temporarily lending out radios. 

• CPS → Tool → Radio recording, update the 

recording page 

2024-11-16 
Not officially 

released 

 

1.6 CPS: V1.02d, Icon: V1.34, SCT 3288: V3_01_01A5 

revision Changes released 

1.02d • Initial firmware 2024-09-10 
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2 Updating the Radioddity GD-168 

Updating the Radioddity GD-168 firmware may involve various steps. As for v1.03 

it requires to update three parts within the Radioddity GD-168 itself (firmware, 

baseband firmware and icons) plus the update of the Radioddity CPS for the 

Radioddity GD-168. Before starting to update your Radioddity GD-168 or your 

Radioddity CPS, save a backup of your current codeplug to a file on your PC. 

Note: Never install any firmware or CPS not originating from Radioddity. Always 

check the availability of the update archive on the Radioddity support page 

for the Radioddity GD-168 prior to performing any update. 

2.1 Backup of current codeplug 

1. In order to avoid any damage of the Radioddity GD-168 CPU or memory, it is 

required to turn off APRS on the Radioddity GD-168 during a firmware 

update. That´s done at the Radioddity GD-168 as follows: 

MENU → APRS → Intervals →Off 

2. Connect the Radioddity GD-168 to your PC using the supplied USB-C to USB-

A cable. 

3. Turn on the Radioddity GD-168. 

Note:  The supplied USB-C to USB-A (programming/charging) cable for the 

Radioddity GD-168 is a plain USB-C to USB-A data-cable and does not 

contain any electronics. In order for the Radioddity GD-168 virtual COM-

port to be visible for the PC, the Radioddity GD-168 needs to be fully 

powered on. 

4. Check your device manager for the virtual COM-port that represents the 

Radioddity GD-168. As for the below example this would be COM4. 

 

5. Start the Radioddity GD-168 CPS and within the menu select. 

Set → Set COM. 
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6. A popup-window will show the available COM-ports. 

 

7. Select the virtual COM-port that corresponds to your Radioddity GD-168. 

8. Before starting to update the firmware or the CPS, we advise to backup your 

current codeplug to a file on your PC. Do so by either clicking in the CPS menu 

on: 

Program → Read From Radio 

 

or by clicking on the appropriate icon to start copying the current codeplug 

from the Radioddity GD-168 to your PC. 

 

9. Please make sure the current codeplug has been saved to your PC before 

you start to update the Radioddity GD-168. 

10. A confirmation dialog will be displayed. 
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11. Transfer both, the “Digital Contact List” and the “Other Data” to the PC. 

 

12. Next save the current codeplug to a file of your choice. We advise to use some 

naming scheme such as “YYYY-MM-DD_RADIODDITY GD-168”. To do so, 

select  

File → Save as 

 

 

13. As soon as the codeplug has been saved to a file a confirmation popup will 

be displayed. 

 

This completes the creation of a codeplug backup file and you are now ready 

to start the actual update process 
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2.2 Updating the main firmware 

1. Connect the Radioddity GD-168 to your PC using the supplied USB-C to USB-

A cable. 

2. Turn off the Radioddity GD-168. 

3. At the Radioddity GD-168 hold both functions keys [PF1] and [PF2] on the left 

side of the radio depressed. 

 

4. Keep the function keys of the Radioddity GD-168 depressed while turning on 

the radio. 

5. The display of the Radioddity GD-168 will remain dark, but the status-LED on 

the top of the radio will start blinking. This indicates that the Radioddity 

GD-168 is now in firmware-update mode. 

6. Release both function keys, [PF1] and [PF2] 

7. Now start the current CPS and select the virtual COM-port that represents 

the Radioddity GD-168. 

8. Now enter the submenu for updating the firmware of the Radioddity GD-168. 

Do so by clicking in the CPS menu on: 

Tool → Firmware and Icon Update 

 

[PF1]-key 

[PF2]-key 
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9. Now click on  and navigate to the “Firmware Update folder” of 

the extracted archive that contains the Radioddity firmware 

GD-168_FW_Vx.xx_YYYYMMDD.spi for updating the radio. 

Note:  Never use any firmware that has not been published by Radioddity. 

There may be radios on the market that look almost the same as the 

Radioddity GD-168 but aren´t the same. Using a firmware not provided 

for the Radioddity GD-168 may brick your radio. 

10. Select the firmware update file ending with “.spi” (1) and confirm your 

selection by clicking on  (2). 

 

11. A confirmation popup will be displayed. Click on . 

 

12. Now the other fields will automatically be filled as well. 
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13. As soon as you now click on  you will be asked one more time if you 

really want to update the radio. 

 

14. As soon as you now confirm the question by clicking on  the 

update process will be started. 

15. A status bar visualizes the progress of the update process. 

 

16. A popup will be shown as soon as the update has completed. 

 

17. The Radioddity GD-168 will automatically reboot. 

 

In order to complete the firmware update process of the Radioddity GD-168, 

it is required to reset the main control unit (MCU) of the radio. 
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2.2.1 Reset Main Control Unit (MCU) 

Before you do anything else it is now required to reset the radio Main Control Unit 

(MCU) of the Radioddity GD-168 as follows. 

1. Turn off the Radioddity GD-168. 

2. Now press the [PTT] and [PF1] key and keep both keys depressed. 

 

 

3. Keep the [PTT] and [PR1] key depressed until you see the following dialog 

on the display of the Radioddity GD-168. 

 

4. Now press the  key at the Radioddity GD-168 to confirm the initialization 

of the radio. 

  

[PF1]-key 

[PTT]-key 
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5. The display of the Radioddity GD-168 will show. 

 

6. After about a minute the Radioddity GD-168 will reboot and display its 

default time zone, time and date. 

  

7. Using the [PF1] key you can now navigate between the various fields and 

update them using the  and  arrow keys of the Radioddity GD-168. 

8. After you made your changes, confirm your changes by clicking on the  

key of your Radioddity GD-168. 

9. The Radioddity GD-168 will reboot. 

10. You will notice, that several submenu entries are missing (due to the radio 

not yet being programmed – we will get back to that later. 
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11. Do not forget to select the proper frequency MODE (region) using the CPS 

(Model → Frequencies). All frequency data will again be cleared. 

 

 

2.2.2 Set frequency MODE (region) 

Before you do anything else the very same frequency MODE (region) also needs to 

be selected on the radio itself. To do so: 

1. Turn off the Radioddity GD-168. 

2. Now press the [PTT] and the numerical [1] key and keep both keys 

depressed. 

3. Keep the [PTT] and the numerical [1] key depressed until you see the 

following dialog on the display of the Radioddity GD-168. 

 

4. Release the [PTT] and the numerical [1] key. 
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5. The bottom line of the display will now show the currently selected MODE 

(region). The line above shows the associated frequency range for that 

region. 

 

Possible regions (MODES) are: 

MODE Region 
UHF Frequency 

range 

VHF Frequency 

range 

00000 Commercial Europe 400-480 MHz 136-174 MHz 

00001 Commercial US 400-480 MHz 136-174 MHz 

00003 Amateur Europe 
RX: 400-480 MHz 

TX: 430-440 MHz 

RX: 136-174 MHz 

TX: 144-146 MHz 

00006 Band 6 446-447 MHz 136 - 174 MHz 

00007 Amateur US 
RX: 400-480 MHz 

TX: 420-450 MHz 

RX: 136-174 MHz 

TX: 144-148 MHz 

00008 Commercial 8 400-470 MHz 136-174 MHz 

00010 
Amateur 

Australia/Canada 

RX: 400-480 MHz 

TX: 430-450 MHz 

RX: 136-174 MHz 

TX: 144-148 MHz 

00013 Commercial 13 
RX: 400-480 MHz 

TX: 403-470 MHz 
136-174 MHz 

00015 Band 15 
RX: 400-480 MHz 

TX: 450-470 MHz 

RX: 136-174 MHz 

TX: 138-174 MHz 

00016 Amateur Thailand 430-440 MHz 144-147 MHz 

00017 Commercial Thailand 
RX: 430-440 MHz 

TX: -/- 
136-174 MHz 

6. Using the channel selector knob you can change the region (MODE) of the 

Radioddity GD-168. 

7. Finally, just turn off the Radioddity GD-168. This will safe the region (MODE) 

setting. 

 

Note: The MODE (Region) set in the CPS has to be identical to those set on the 

Radioddity GD-168 in order to avoid later conflicts when reading/writing a 

codeplug. 

This completes the reset process. 
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2.3 Updating the icons 

1. Turn off the Radioddity GD-168. 

2. Press the [PTT] and the [PF2] key on the left side of the Radioddity GD-168. 

 

3. Keep both keys depressed while turning on the Radioddity GD-168. 

4. As soon as the display of the Radioddity GD-168 will show “UPDATE MODE”, 

you may release both keys. 

 

5. Now connect the Radioddity GD-168 to your PC using the supplied USB-C to 

USB-A cable. 

6. Start the current CPS and select the virtual COM-port that represents the 

Radioddity GD-168. 

  

[PF2]-key 

[PTT]-key 
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7. Now enter the CPS submenu for updating the icons of the Radioddity 

GD-168. Do so by clicking in the CPS menu on: 

Tool → Firmware and Icon Update 

 

8. Now click on  and navigate to the “Icon Update folder” of the 

extracted archive that contains the Radioddity file 

GD-168_ICON_Vx.xx_YYYYMMDD.spi for updating the icons of the radio. 

Notes:  Never use any icon file that has not been published by Radioddity. There 

may be radios on the market that look almost the same as the 

Radioddity GD-168 but aren´t the same. Using a icon file not provided 

for the Radioddity GD-168 may brick your radio. 

9. Select the Program Update File ending with “.spi” (1) and confirm your 

selection by clicking on  (2). 
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10. A confirmation popup will be displayed: 

 

11. This time there will not be any details shown for “Model” or “Version”: 

 

12. As soon as you now click on  you will be asked one more time if you 

really want to update the radio. 

 

13. As soon as you now confirm the question by clicking on  the 

update process will be started. 
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14. A status bar visualizes the progress of the update process. 

 

15. A popup will be shown as soon as the update has completed. 

 

16. The Radioddity GD-168 will not automatically reboot. 

17. Turn off the Radioddity GD-168. 

 

The completes updating the icons of the Radioddity GD-168  
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2.4 Updating the 3288 base band firmware 

1. Turn off the Radioddity GD-168. 

2. Close any running Radioddity GD-168 CPS. This will allow the virtual COM-

port that represents the Radioddity GD-168 to be used at a later step for 

upgrading the 3288 base band firmware. 

3. Press the [PTT] key on the left side of the Radioddity GD-168 and the [#] key 

at the lower right front side of the Radioddity GD-168. 

 

4. Keep both keys depressed while turning on the radio. 

5. You may release both keys as soon as the display of the Radioddity GD-168 

will show: 

 

 

6. The displayed warning will not change 

7. Now connect the Radioddity GD-168 to your PC using the supplied USB-C to 

USB-A cable. 

  

[PTT]-key 
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8. Within the directory “Baseband Update program” start the program 

. 

 

9. If not already selected, select “SCT3288” within the popup: 

 

10. Confirm your selecting by clicking on . 
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11. Within the menu select Tools → Config and select the virtual COM-port that 

represents the Radioddity GD-168. The Speed (*Port Rate’) should be kept at 

38400 bps. 

 

12. Confirm your selecting by clicking on . 

13. Within the menu select SCT_PORT → Flash Update: 

 

14. In order to initialize the virtual COM-port click on . 

 



Radioddity Radioddity GD-168 update v1.07 

 

 © Radioddity 2025 page 24/33 

 
 
 
 

15. Next click on the three dots to navigate to the directory “Baseband Update 

folder” containing the base band update file. 

 

16. Navigate to the folder containing the hex file for the baseband update 

SCT3288TD_UpdateFlash_Vx_xx_xxxx.hex. 

 

17. Select the file (1) and click on  (2). 
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18. Now click on  to start the update process. 

 

19. You will see a progress bar representing the current status of the baseband 

update: 
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20. As soon as the update has finished the screen will look similar to: 

 

21. Finally click on  to exit from this submenu. 

22. The exit the program, click on File → Exit. 

23. Turn off the Radioddity GD-168. 

 

This completes the baseband update of the Radioddity GD-168. 
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2.5 Updating the CPS 

As each firmware version resides in a different directory (according to the version 

number). So, is safe to just install the new CPS by navigating to the CPS folder and 

starting the installation program. 

 

Choose ‘English’ language and hit ‘OK’. 
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Next you will be asked for the installation directory. Be aware that by default drive 

“D:” will be used for the install. If you do not have a drive D:, change that to your 

normal boot drive (C:). 

 

Next you will be asked for the name of the program´s shortcut within the Start 

Menu folder. 
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Creating a shortcut on your desktop often is a good idea. So, make sure the 

checkbox has been ticked before you click on ‘Next’ if you want a shortcut to 

become available on your desktop. 

 

You will then get a summary of your selections. Hit ‘Install’ to start the actual 

installation process. 
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For just a few seconds you will see the installation progress bar. 

 

As soon as the installation has been completed, you may directly start the CPS. 

 

This completes the CPS installation. 
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3 Where to find further information? 

On the Internet you will find a variety of sources with information about the 

Radioddity GD-168. When watching videos make sure that the Radioddity GD-168 

in the video is at the same firmware level as yours (features can change and bugs 

may be fixed between firmware versions). 

3.1 Radioddity support area 

Please note that you can find all firmware, software and user manuals in the 

support section of our official Radioddity website by following these steps: 

https://www.radioddity.com/ → Support → Radioddity → GD-168 

For the Radioddity GD-168, the resulting support page looks something like this: 

 

As soon as a new file is available (e.g., firmware updates, updated manuals or 

others), these files will be published in our Radioddity GD-168 support area. 

  

https://www.radioddity.com/
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We would like to thank all Radioddity customers for their constructive feedback. 

If you find an error in the firmware of the Radioddity GD-168, its CPS or in this 

documentation, or if you miss a function that you would have expected, or even 

if a detail has not been described to the expected extent, please feel free to write 

a message to support@radioddity.com. In general, firmware updates for your 

Radioddity GD-168 are free of charge. The use of Radioddity firmware for this 

radio may invalidate the warranty or even brick your radio. Such will not be 

covered by our warranty. 

 

 

 

Thank You for Shopping at Radioddity! 

FIND TUTORIALS, SUPPORT AND MORE AT: 

 

 

https://www.radioddity.com/  

 

 

 

https://www.facebook.com/radioddity  

 

 

 

https://www.youtube.com/c/Radioddityradio 
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